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	2
	
	CN
	Bài 9. Mô hình máy phát điện gió (tiết 1)

	T5, 6/3 
(Sáng)
	1
	3B
	Tin học
	Bài 1. Em làm quen với phần mềm trình chiếu

	
	2
	
	CN
	Bài 7: Làm đồ dùng học tập (tiết 4)

	
	3
	4B
	Tin học
	Bài 7. Thực hành tổng hợp chủ đề "Tập  soạn thảo văn bản"

	
	4
	
	CN
	Bài 10. Lắp ghép mô hình robot (tiết 1)

	T5, 6/3
(Chiều)
	1
	3A
	TNXH
	Bài 16: Cơ quan tuần hoàn (tiết 3)

	
	2
	
	
	Bài 17: Cơ quan thần kinh (tiết 1) 

	T6, 7/3 
(Sáng)
	3
	3B
	TNXH
	Bài 16: Cơ quan tuần hoàn (tiết 3)

	
	4
	
	
	Bài 17: Cơ quan thần kinh (tiết 1) 


Ngày duyệt: 28/02/2025                             

                                                                                         BGH kí duyệt:

PHT. Nguyễn Thị Hằng

	Tuần: 24
Buổi chiều
Lớp: 4C
Tiết 1
	Thứ hai, ngày 03 tháng 3  năm 2025
Tin học 
Bài 7. Thực hành tổng hợp 

chủ đề "Tập  soạn thảo văn bản"


I. YÊU CẦU CẦN ĐẠT

- Rèn luyện được kĩ năng tạo tệp văn bản có ảnh.

- Rèn luyện được kĩ năng sửa văn bản với các thao tác chọn, xóa, sao chép, di chuyển khối văn bản.

1. Về năng lực 

 Năng lực chung:

· Năng lực giao tiếp và hợp tác: Trao đổi, giúp đỡ nhau trong học tập; cùng bạn hoàn thành rèn kĩ năng thực hành các thao tác với tệp và khối văn bản.

Năng lực Tin học:

· Năng lực NLd: Rèn kĩ năng thực hành các thao tác tạo  tệp văn bản theo chủ đề có ảnh minh họa.

2. Về phẩm chất

· Chăm chỉ: Hăng hái, tích cực thực hiện nhiệm vụ học tập trong soạn thảo văn bản theo chủ đề cho trước có ảnh minh họa.
· Trách nhiệm: Hoàn thành đầy đủ các nhiệm vụ học tập trong việc soạn thảo văn bản theo chủ đề có ảnh minh họa.

II. ĐỒ DÙNG DẠY – HỌC


- GV: SGK, SGV, bài giảng điện tử.


- HS: SGK, SBT, vở ghi.

III. CÁC HOẠT ĐỘNG DẠY HỌC

	Hoạt động của GV
	Hoạt động của HS

	- Kiểm tra sĩ số.

1. Khởi động, trải nghiệm(4’)

Mt: Tạo hứng thú cho HS. Củng cố lại việc nhận ra các lợi ích của phần mềm soạn thảo văn bản.

- Tổ chức cho HS chơi trò chơi “Ai nhanh ai đúng”. Gv chiếu câu hỏi tương tác trên trang Web Hoc10.vn.  Khi có hiệu lệnh “Bắt đầu” ai giơ tay nhanh nhất sẽ được quyền trả lời. Nếu trả lời đúng sẽ là người thắng cuộc. Nếu trả lời sai sẽ nhường quyền trả lời cho bạn khác.
- GV tổng kết trò chơi, tuyên dương kết hợp giới thiệu bài, ghi đầu bài lên bảng

2. Thực hành, luyện tập (21’)

Hoạt động 2.1: Thực hành các thao tác cơ bản với tệp và khối văn bản (11’)

MT:  HS rèn kĩ năng thực hành các thao tác với tệp và khối văn bản

- GV chiếu yêu cầu. Cho HS đọc thầm phần hướng dẫn thực hành  ở mục 1 SGK trang 46, thảo luận theo nhóm máy rồi thực hiện tạo 1 tệp văn bản như hình 1 lưu với tên tệp là “Khi mẹ vắng nhà”. Sau đó lưu tệp này với tên mới là “Văn bản sửa” rồi sửa nội dung như hình 2.

- GV theo dõi, hỗ trợ HS yếu

- Nhận xét, tuyên dương, chấm 1 số HS

- Gọi đại diện1 số nhóm đã thực hiện  được nêu lại cách thực hiện

- Gọi HS nhóm khác nhận xét

- GV nhận xét, tuyên dương

- GV nhận xét và chốt lại cách làm: 
+ Tạo tệp mới: File -> New

+ Sử dụng các lệnh Copy và Paste để sao chép cụm từ “khi mẹ vắng nhà”

+ Lưu văn bản: File ->Save

+ Lưu tệp với tên mới: File ->Save As

+ Sử dụng các lệnh Cut và Paste để di chuyển câu thơ

Hoạt động 2.2: Thực hành tạo tệp văn bản để viết về 1 chủ đề, có ảnh minh họa (10’)
MT:  HS rèn kĩ năng thực hành tạo tệp văn bản có ảnh minh họa

- GV chiếu yêu cầu. Cho HS đọc thầm phần hướng dẫn thực hành  ở mục 2 SGK trang 47, thảo luận theo nhóm máy rồi nêu lại cách thực hiện mở tệp văn bản “Khi mẹ vắng nhà” thêm nội dung và chèn ảnh phù hợp như hình 3 sau đó lưu tệp này với tên mới là “Giúp đỡ gia đình” .

- Gọi đại diện1 số nhóm nêu ý kiến

- Gọi HS nhóm khác nhận xét

- GV nhận xét và chốt lại cách làm: 
+ Mở tệp đã có: File -> Open

+ Chèn hình ảnh: Insert ->Pictures

+ Lưu tệp với tên mới: File ->Save As

- Cho HS thực hành soạn thảo văn bản theo nhóm máy

- GV theo dõi, hỗ trợ HS yếu

- Nhận xét, tuyên dương, chấm 1 số HS

3.Vận dụng, trải nghiệm(10’)
MT: HS rèn kĩ năng thực hành tạo tệp văn bản theo ý thích

- Gv chiếu yêu cầu

- Cho HS thực hành soạn thảo văn bản có nội dung là 1 khổ thơ hoặc 1 đoạn văn, chèn ảnh phù hợp rồi lưu lại với tên tệp là tên bài thơ hoặc tên câu chuyện trong thư mục Tap soan thao
-  GV theo dõi, hỗ trợ HS yếu

- Nhận xét, tuyên dương, chấm 1 số HS

- GV chiếu lại các phần chốt kiến thức

- Gọi 1 HS đọc to trước lớp

- Dặn HS về nhà học thuộc phần chốt kiến thức
	- Chơi trò chơi

- Nghe, ghi đầu bài vào vở

- Đọc yểu cầu, thảo luận và thực hiện trên máy

- Lắng nghe, vỗ tay

- Đại diện 1 số nhóm trả lời

- Nhận xét

- Lắng nghe, vỗ tay

- Lắng nghe

- Đọc yểu cầu, thảo luận 

- Đại diện 1 số nhóm trả lời

- Nhận xét

- Lắng nghe

- Thực hành theo nhóm máy

- Lắng nghe, vỗ tay

- Đọc yểu cầu, thực hiện trên máy

- Lắng nghe, vỗ tay

- Quan sát

- 1 HS đọc to trước lớp

- Ghi nhớ


IV. Điều chỉnh sau bài dạy
………………………………………………..……………………………………………….……………………………………………….…………………………


	Lớp: 4A


	

Thứ  hai, ngày  03  tháng 3 năm 2025

Công nghệ

Bài 10. Lắp ghép mô hình robot (tiết 1)


I. Yêu cầu cần đạt:

Bài học này nhằm hình thành và phát triển ở HS năng lực và phẩm chất với những biểu hiện cụ thể như sau:

1. Năng lực

a. Năng lực công nghệ

- Năng lực nhận thức công nghệ: Nhận biết được các bộ phận chính và yêu cầu sản phẩm mô hình robot.

- Năng lực sử dụng công nghệ

+ Lựa chọn được dụng cụ, chi tiết, lắp ghép mô hình robot đúng yêu cầu.

+ Lắp ghép được mô hình robot theo hướng dẫn

+ Sử dụng, chơi mô hình robot đúng cách.

- Năng lực đánh giá công nghệ: Giới thiệu được sản phẩm do mình làm và nhận xét được sản phẩm theo các tiêu chí đánh giá.

b. Năng lực chung

- Năng lực tự chủ và tự học: Tự lực lắp ghép được mô hình theo sự phân công, hướng dẫn và đúng thời gian quy định.

- Năng lực giải quyết vấn đề và sáng tạo: Hình thành được ý thức làm việc theo quy trình.

2. Phẩm chất

- Chăm chỉ: Có ý thức thực hành nghiêm túc, luôn cố gắng đạt kết quả tốt.

- Trách nhiệm: Có ý thức giữ gìn dụng cụ, chi tiết lắp ghép, nhắc nhở mọi người chấp hành đúng quy định về gọn gàng, ngăn nắp sau giờ học.

II. Đồ dùng dạy học

- Bộ lắp ghép mô hình kĩ thuật; danh mục chi tiết, dụng cụ cần dùng để lắp một mô hình robot

- Một số hình ảnh mô hình robot trong SGK, tiến trình lắp ghép mô hình robot

- Sưu tầm thêm hình ảnh một số mô hình robot

- Video hướng dẫn các bước tiến hành lắp ghép mô hình robot

- Máy tính, máy chiếu

III. Các hoạt động dạy học chủ yếu

	Hoạt động của GV
	Hoạt động của HS

	1. Hoạt động khởi động

a. Mục tiêu: Tạo hứng thú và nhu cầu tìm hiểu cách lắp ghép mô hình robot

b. Tổ chức thực hiện

	- Yêu cầu quan sát hình trong phần khởi động trang 49 SGK và trả lời câu hỏi: Sản phẩm này tên là gì? Chơi như thế nào?


[image: image1.png]



- Yêu cầu đọc câu hỏi khởi động và trả lời: Em hãy quan sát hình và cho biết đâu là mô hình robot được lắp ghép từ bộ lắp ghép mô hình kĩ thuật?

- Yêu cầu HS trả lời câu hỏi

- Nhận xét, đưa câu trả lời: Hình 2 là mô hình robot lắp ghép bằng bộ lắp ghép kĩ thuật.

- Dẫn dắt cùng tìm hiểu cách lắp ghép mô hình robot bằng bộ lắp ghép mô hình kĩ thuật.
	- Quan sát và trả lời

- Đọc câu hỏi và trả lời

- Nhận xét và bổ sung

	2. Hoạt động khám phá

A. Sản phẩm mẫu

Xác định bộ phận chính và yêu cầu sản phẩm mô hình robot

a. Mục tiêu: Nhận biết được các bộ phận chính và yêu cầu sản phẩm của mô hình robot

b. Tổ chức thực hiện

	- Yêu cầu quan sát sản phẩm, đọc nội dung mục A. Sản phẩm mẫu trang 49 SGK và trả lời 2 yêu cầu: 

+ Em hãy nêu tên các bộ phận chính của mô hình robot

+ Hãy nêu yêu cầu sản phẩm mô hình robot

- Gọi HS trả lời

- Nhận xét và đưa đáp án

+ Mô hình robot gồm đầu robot, thân robot, chân robot, tay robot

+ Yêu cầu sản phẩm: Lắp ghép đầu đủ, đúng các chi tiết, mối ghép giữa các chi tiết chắc chắn, chân mô hình robot chuyển động được, cánh tay mô hình robot nâng lên, hạ xuống được.

- Chốt kiến thức: 

+ Các bộ phận chính của mô hình robot: 4 bộ phận chính (đầu robot, thân robot, chân robot, tay robot), cần lắp ghép từng bộ phận chính rồi mới lắp 4 bộ phận chính thành sản phẩm hoàn chỉnh.

+ Các yêu cầu sản phẩm mô hình robot dùng để đánh giá sản phẩm do HS làm ra.
	- Quan sát mẫu và trả lời câu hỏi

- 1-2HS trả lời, nhận xét và bổ sung.

- Đọc lại câu trả lời

- Nghe, nhắc lại cách làm

	3. Hoạt động thực hành

B. Chuẩn bị chi tiết và dụng cụ lắp ghép

Chuẩn bị dụng cụ, chi tiết để lắp ghép mô hình robot

a. Mục tiêu: Lựa chọn được dụng cụ và chi tiết để lắp ghép mô hình robot đúng yêu cầu

b. Tổ chức thực hiện

	- Yêu cầu thảo luận nhóm đôi, yêu cầu quan sát hình ảnh mẫu trong SGK trang 49, hình ảnh các dụng cụ, chi tiết gợi ý trong bảng thống kê trang 50 SGK và thảo luận lựa chọn chi tiết, dụng cụ và lấy đúng số lượng cần thiết.

- Thống nhất với HS cùng lấy số lượng các dụng cụ, chi tiết cần thiết để lắp ghép mô hình robot
	- Quan sát, thảo luận

- Lựa chọn các dụng cụ , chi tiết

- HS lấy từ bộ lắp ghép mô hình kĩ thuật đầy đủ các chi tiết, dụng cụ cần thiết, sắp xếp ở từng khu vực khác nhau để dễ quan sát và dễ lấy.


IV. Điều chỉnh sau bài dạy
………………………………………………..………………………………………………………….……………………………………………………….………

	Lớp: 4C

	Thứ ba, ngày 04 tháng 3 năm 2025

Tin học 

Bài 7. Thực hành tổng hợp Chủ đề “tập soạn thảo văn bản”

	
	Công nghệ

Bài 10. Lắp ghép mô hình robot (tiết 1)


**Đã soạn như bài của lớp 4A vào chiều thứ hai, ngày 03/3/2025

	Lớp: 5A


	Thứ ba, ngày 04 tháng 3 năm 2025

Tin học

Bài 5. Cấu trúc tuần tự


I. Yêu cầu cần đạt:

1. Về năng lực:

Năng lực chung:

+ Năng lực tự chủ và tự học: Tìm được ví dụ về cấu trúc tuần tự.

+ Năng lực giao tiếp và hợp tác: Biết hợp tác với các bạn để tạo chương trình sử dụng cấu trúc tuần tự.

+ Năng lực giải quyết vấn đề và sáng tạo: Biết áp dụng cấu trúc tuần tự vào học tập thực tế.

Năng lực tin học:

+ Năng lực NLe: Sử dụng phần mềm tạo chương trình đơn giản sử dụng cấu trúc tuần tự.

2. Về phẩm chất:
+ Chăm chỉ: Hăng hái, tích cực thảo luận nhóm để tìm ví dụ về cấu trúc tuần tự.

+ Trách nhiệm: Hoàn thành đầy đủ nhiệm vụ, hướng dẫn bạn cùng nhóm thực hiện các yêu cầu của bài học.

II. Đồ dùng học tập:

GV: SGK, SBT.

HS: SGK, SBT.
III. Các hoạt động dạy và học:

	Hoạt động của giáo viên
	Hoạt động của học sinh

	1. Hoạt động khởi động (3’)

a. Mục tiêu: Tạo tâm thế vào bài học mới cho HS, gợi mở về bài học

b. Tổ chức hoạt động:

	- GV nêu yêu cầu của phần khởi động và gọi 1 HS lên thực hiện nhiệm vụ.

- GV gọi đại diện HS trả lời câu hỏi

- GV chốt kiến thức: 
* Các bước sao chép một tệp vào thư mục khác:
+ Bước 1: Nháy chuột vào dải lệnh Home

+Bước 2: Chọn thư mục chứa tệp cần sao chép

+ Bước 3: Chọn tệp cần sao chép

+ Bước 4: Nháy chuột vào lệnh Copy

+ Bước 5: Chọn thư mục lưu.
* Nếu thay đổi thứ tự thực hiện các bước trên thì em không thể sao chép được.

- GV gợi mở vào bài học 
	- HS lắng nghe để thực hiện nhiệm vụ

- Trả lời câu hỏi
- Nghe
- Nghe

	2. Hoạt động 2: Hình thành kiến thức mới 

Hoạt động 2.1. Cấu trúc tuần tự. (10’)

a. Mục tiêu: Nêu được ví dụ về cấu trúc tuần tự

b. Nội dung và sản phẩm:

- Kiến thức: Cấu trúc tuần tự .

- Yêu cầu: Thực hiện yêu cầu trong hoạt động 1 trong SGK trang 58.
- Sản phẩm: Hoàn thành hoạt động 1.

c. Tổ chức hoạt động:

	- Yêu cầu HS đọc yêu cầu của hoạt động 1 trang 58 SGK.
- GV nêu một số câu hỏi định hướng trong lúc thực hiện nhiệm vụ:

+ Bài cho biết gì?

+ Bài yêu cầu gì?

- Gọi 1 HS trả lời câu hỏi gợi ý.

- Nhận xét câu trả lời.

- Hướng dẫn HS trả lời .
- Gọi HS trả lời

- Gọi HS khác nhận xét
- GV chốt đáp án:
- GV chốt kiến thức.

- Yêu cầu đọc kết luận trang 59 SGK.
	- Đọc yêu cầu của hoạt động.
- Nghe

- 1 HS trả lời:
+ Bài cho biết: Cách để tạo chương trình vẽ 3 con bọ.

+ Bài yêu cầu: Bản hướng dẫn của bạn Bình và bạn Tú bạn nào giúp tạo chương trình thuận lợi hơn.

- Nghe

- Trả lời

- Trả lời

- Nhận xét

- Nghe

- Nghe

- Đọc kết luận.

	2.2. Chương trình có cấu trúc tuần tự (10’)

a. Mục tiêu: Giúp HS tạo được chương trình sử dụng cấu trúc tuần tự.

b. Nội dung và sản phẩm:
- Kiến thức: Cách ghép câu lệnh thành cấu trúc tuần tự.

- Yêu cầu: Thực hiện hoạt động 2 trang 59 SGK.

- Sản phẩm: Hoàn thành hoạt động 2.

c. Tổ chức hoạt động:

	- GV yêu cầu đọc nội dung hoạt động 2 trong SGK trang 59.

- Chia nhóm 2HS một máy thực hiện hoạt động

- Quan sát HS thực hiện, giúp đỡ HS còn gặp khó khăn.

- Gọi 1,2 nhóm HS báo cáo kq.

- Gọi 1 HS của nhóm khác nhận xét

- GV nhận xét

- GV chốt kiến thức

- Yêu cầu đọc nội dung trong SGK trang 60.
	- Đọc yêu cầu.

- Chia nhóm thực hiện.

- Hỏi lại GV nếu cần

- Thực hiện yêu cầu

- Nhận xét

- Nghe

- Nghe

- Đọc.

	3. Hoạt động luyện tập (5’)

a. Mục tiêu: Giúp HS củng cố được kiến thức

b. Nội dung và sản phẩm:
- Yêu cầu: Thực hiện phần luyện tập trang 60 SGK
- Sản phẩm: Trả lời được yêu cầu của bài luyện tập

c. Tổ chức hoạt động:

	- GV nêu yêu cầu của hoạt động luyện tập và làm việc chung với cả lớp.

- Gọi 1HS lên tra lời câu hỏi

- GV quan sát nghe và nhận xét
- GV hướng dẫn các thao tác mà HS còn gặp khó khăn chưa thực hiện được.
	- HS làm việc cá nhân, lắng nghe và quan sát GV hướng dẫn để hiểu nhiệm vụ.
- HS trả lời

- Nghe nhận xét
- Quan sát và hỏi lại GV

	4. Hoạt động vận dụng (7’)

a. Mục tiêu: HS biết vận dụng tạo chương trình có cấu trúc tuần tự.
b. Nội dung và sản phẩm:
- Yêu cầu: Thực hiện bài vận dụng trong SGK trang 60.
- Sản phẩm: Trả lời được yêu cầu của bài vận dụng.

c. Tổ chức hoạt động:

	- GV nêu yêu cầu của bài vận dụng
- GV tổ chức cho HS thực hiện bài vận dụng
Có thể hướng dẫn về nhà làm

- Yêu cầu đọc ghi nhớ trong SGK trang 60
	- Nghe

- Chia nhóm thực hiện yêu cầu

- Nghe

- Đọc ghi nhớ SGK.


IV. Điều chỉnh sau bài dạy
…….……………………………………………….………………………………

	Lớp: 5A
	

Thứ  ba, ngày  04  tháng 3 năm 2025
Công nghệ
Bài 9. Mô hình máy phát điện gió (tiết 1)


I. Yêu cầu cần đạt

1. Về năng lực

Năng lực chung

- Năng lực tự chủ và tự học: Chủ động, tự lực, tích cực trong tìm hiểu cách tạo ra điện từ gió, tìm hiểu quy trình và lắp ráp mô hình.

- Năng lực giao tiếp và hợp tác: Hình thành thói quen trao đổi, giúp đỡ nhau trong học tập, biết cùng nhau hoàn thiện nhiệm vụ học tập theo sự hướng dẫn của GV.

- Năng lực giải quyết vấn đề và sáng tạo: Lắp ráp và vận hành được mô hình theo quy trình nêu trong SGK và hướng dẫn của GV.

Năng lực công nghệ

- Năng lực nhận thức công nghệ: Mô tả được cách tạo ra điện từ gió. Kể tên và nhận biết được các bộ phận chính của mô hình máy phát điện gió.

- Năng lực sử dụng công nghệ:

+ Lựa chọn được các chi tiết phù hợp của mô hình máy phát điện gió.

+ Lắp ráp được mô hình máy phát điện gió.

- Năng lực đánh giá công nghệ: Kiểm tra, đánh giá được chất lượng lắp ráp và khả năng hoạt động của mô hình với các tốc độ gió khác nhau.

2. Về phẩm chất

- Chăm chỉ: Thường xuyên hoàn thành nhiệm vụ học tập, có ý thức vận dụng kiến thức, kĩ năng học được ở nhà trường vào đời sống hằng ngày.

- Trách nhiệm: Có ý thức giữ gìn dụng cụ làm thủ công và ý thức tiết kiệm vật liệu làm mô hình điện gió.

II. Đồ dùng dạy học

- GV : SGK, SBT, bộ lắp ghép mô hình kĩ thuật, tranh ảnh trong SGK.

- HS: SGK, SBT, bộ lắp ghép mô hình kĩ thuật.

III. Các hoạt động dạy học chủ yếu

	Hoạt động của giáo viên
	Hoạt động của học sinh

	1. Hoạt động khởi động (5’)

a. Mục tiêu: Tạo hứng thú và nhu cầu tìm hiểu về máy phát điện gió

b. Tổ chức thực hiện:

	- GV yêu cầu HS quan sát tranh trong SGK trang 51

- Yêu cầu HS trả lời câu hỏi: Kia có phải là máy phát điện gió không nhỉ?

- GV gọi HS trả lời

- Gọi HS khác nhận xét

- GV nhận xét, dẫn dắt vào bài học.
	- Quan sát tranh trong SGK

- Đọc câu hỏi

- Trả lời

- Nhận xét

- Nghe.

	2. Hoạt động hình thành kiến thức

Cách tạo ra điện từ gió (25’)

a. Mục tiêu: Mô tả được cách tạo ra điện gió và các bộ phận chính của mô hình máy phát điện gió.

b. Tổ chức thực hiện:

	- GV yêu cầu HS quan sát các hình 1,2,3 trang 51 SGK và trả lời câu hỏi: Năng lượng gió có tác dụng gì đối với các sản phẩm công nghệ trong hình dưới đây?

- GV yêu cầu thảo luận nhóm đôi trả lời câu hỏi trên.

- GV gọi từng nhóm trả lời theo hình

- GV gọi nhóm khác nhận xét

- GV nhận xét, chốt đáp án:

+ Hình 1: Làm thuyền buồm di chuyển

+ Hình 2: Làm cánh quạt của cối xay gió quay để bơm nước

+ Hình 3: Làm cánh quạt của máy phát điện quay để tạo ra điện.

- GV chốt kiến thức: Gió là nguồn năng lượng tự nhiên, có thể sử dụng gió để phục vụ nhiều mục đích khác nhau trong cuộc sống như: di chuyển, bơm nước, xay thóc, tạo ra điện,…

- GV yêu cầu HS đọc phần ghi nhớ kiến thức trang 52 SGK.

- Tiếp theo GV yêu cầu HS thảo luận phần khám phá trang 52 SGK: Dựa vào hình và thông tin gợi ý, hãy sắp xếp các thẻ dưới đây cho đúng trình tự tạo ra điện từ gió.

- Yêu cầu HS thảo luận nhóm đôi sau đó gọi các nhóm thực hiện ghép thẻ.

- GV gọi nhóm khác nhận xét, bổ sung

- GV nhận xét, tuyên dương nhóm nào thực hiện tốt.
	- Quan sát hình

- Thảo luận nhóm đôi.

- Trả lời

- Nhận xét

- Nghe, ghi bài.

- Nghe, ghi bài

- Đọc to ghi nhớ

- Thảo luận nhóm đôi

- Thảo luận ghép thẻ

- Nhận xét, bổ sung

- Nghe.

	3. Hoạt động vận dụng (5’)

a. Mục tiêu: Giúp HS biết được điện gió được ứng dụng vào đời sống ở đâu

b. Tổ chức thực hiện:

	- GV yêu cầu HS đọc nội dung phần em có biết trang 53 SGK

- Gọi 1, 2HS đọc 

- GV yêu cầu HS đọc ghi nhớ kiến thức trang 53 SGK
	- Đọc em có biết

- Đọc ghi nhớ.


IV. Điều chỉnh sau bài dạy
…….……………………………………………….………………………………
	Lớp: 5B


	Thứ tư, ngày 05 tháng 3 năm 2025

Tin học

Bài 5. Cấu trúc tuần tự

	
	Công nghệ

Bài 9. Mô hình máy phát điện gió (tiết 1)


** Đã soạn như bài của lớp 5A vào sáng thứ ba, ngày 04/3/2025


	Lớp: 3A


	Thứ tư, ngày 05 tháng 3 năm 2025

Tin học

Bài học. Bảo vệ thông tin cá nhân


I. YÊU CẦU CẦN ĐẠT

1. Kiến thức, kĩ năng:


- Biết được thông tin cá nhân và gia đình có thể được lưu trữ và trao đổi nhờ máy tính.


- Biết được việc người xấu có thể lợi dụng thông tin cá nhân và gia đình để gây hại cho em và gia đình.


- Có ý thức bảo vệ thông tin cá nhân và gia đình khi giao tiếp qua máy tính.

2. Phầm chất, năng lực
a. Phẩm chất:

- Nhân ái: Yêu quý bạn bè, thầy cô; quan tâm, động viên, khích lệ bạn bè.
- Chăm chỉ: Đi học đầy đủ, đúng giờ. Thường xuyên hoàn thành nhiệm vụ học tập.

- Trung thực: Không tự tiện lấy đồ vật, tiền bạc của người thân, bạn bè, thầy cô và những người khác.
     - Trách nhiệm: Có ý thức giữ gìn vệ sinh, rèn luyện thân thể, chăm sóc sức khoẻ. Có ý thức sinh hoạt nền nếp.

b. Năng lực:

 Năng lực chung:


- Năng lực tự chủ và tự học: Tự làm được những việc của mình ở nhà và ở trường theo sự phân công, hướng dẫn.


- Năng lực giao tiếp và hợp tác: Nhận ra được ý nghĩa của giao tiếp trong việc đáp ứng các nhu cầu của bản thân.


- Năng lực giải quyết vấn đề và sáng tạo: Biết xác định và làm rõ thông tin, ý tưởng mới đối với bản thân từ các nguồn tài liệu cho sẵn theo hướng dẫn.

Năng lực riêng:


- Học xong bài này học sinh biết được việc quan trọng của bảo vệ thông tin cá nhân và gia đình khi sử dụng máy tính, internet.

II. ĐỒ DÙNG DẠY HỌC

1. Giáo viên: Máy tính, máy chiếu, sách giáo khoa.

2. Học sinh: Sách giáo khoa, vở ghi

III. CÁC HOẠT ĐỘNG DẠY HỌC

	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	1. HOẠT ĐỘNG MỞ ĐẦU

	KTBC: Em hãy tạo thư mục tên của em trong ổ D:

- Nhận xét – tuyên dương.

- Kẻ xấu thường lây cắp thông tin cá nhân trên Internet của một số người rồi dùng thông tin này gây hại cho họ. Trên ti vi có nhiều bản tin về điều này. Nếu em biết được những bản tin như thế, hãy kể cho cả lớp cùng biết.

- Hôm nay, các em sẽ học bài “Sử dụng thông tin cá nhân trong môi trường số một cách phù hợp”
	- HS thực hiện

- Nhận xét bạn

- HS trả lời.

- Hs viết bài.

	2. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

	Hoạt động 1: Thông tin cá nhân có thể được lưu trữ và trao đổi bởi máy tính

- (?) Em hãy cho biết một vài thông tin của gia đình em được lưu trữ ở máy tính hoặc điện thoại của bố, mẹ.

- Nhận xét.

Hoạt động 2: Vì sao phải bảo vệ thông tin khi giao tiếp trên internet.

- (?) Vì sao em phải bảo vệ thông tin cá nhân và gia đình khi giao tiếp trên Internet?

- Nhận xét.
	- Hs trả lời.

- Thông tin cá nhân và gia đình có thể được lưu trữ và trao đổi nhờ máy tính. Ví dụ: số điện thoại, ảnh kỉ niệm, video lưu lại những sự kiện của gia đình, những thông tin liên quan đến việc mua bán, trả phí hoặc công việc riêng.

- Quan sát nhận xét bạn.

- Khi giao tiếp trên Internet, em không nên tuỳ tiện cung cấp nhung thông tin cá nhân và gia đình, ví dụ như: họ tên, địa chỉ nhà, số điện thoại, tên các thành viên trong gia đình, thẻ thanh toán trực tuyến,... Vì nếu để lộ kẻ gian có thể sử dụng thông tin đó để lừa đảo, giả mạo, bắt cóc bạn bè, người thân của người đó,…..

	3. HOẠT ĐỘNG LUYỆN TẬP, THỰC HÀNH

	- Theo em, những thông tin nào dưới đây là thông tin cá nhân và gia đình?

1)
Địa chỉ của trường em.

2)
Số điện thoại của bố, mẹ em.

3)
Địa chỉ nơi làm việc của thành viên trong gia đình.

4)
Tên đầy đủ của em và các thành viên trong gia đình..

- GV nhận xét – tuyên dương.
	- HS thảo luận trả lời

- Đúng.

- Đúng

- Đúng.

- Đúng.



	4. HOẠT ĐỘNG VẬN DỤNG, TRẢI NGHIỆM

	- Nếu tuỳ tiện đưa ra thông tin cá nhân khi giao tiếp trên Internet thì kẻ xấu có thể lợi dụng thông tin này để làm những gì có hại cho em?

- GV nhận xét – tuyên dương.

- YC học sinh đọc phần em cần ghi nhớ.
	- HS thảo luận.

- Hs trả lời: lừa đảo, bắt cóc, chiếm đoạt tài sản.

- Hs đọc.


IV. ĐIỀU CHỈNH SAU BÀI DẠY
……………………………………………………………………………………
	Lớp 3A

Tiết 2
	Thứ tư, ngày 26 tháng 2 năm 2025
Công nghệ

Bài 7: Làm đồ dùng học tập (tiết 4)

(Làm ống đựng bút – t2)


- Nhận xét 

	au tiết dạy, dặn dò về nhà.

	- Các nhóm thảo luận đưa ra ý tưởng cho nhóm mình.

- HS đọc 

- HS lắng nghe

- HS chọn ý tưởng

- HS về nhà hoàn thiện SP

- HS lắng nghe, rút kinh nghiệm
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	Buổi chiều

Lớp: 3A
Tiết 1
	Thứ năm, ngày 06 tháng 3 năm 2025
Tự nhiên và xã hội
 Bài 16. Cơ quan tuần hoàn (tiết 3)


I. YÊU CẦU CẦN ĐẠT
1. Về nhận thức khoa học
- Chỉ và nói được tên các bộ phận chính của cơ quan tuần hoàn trên sơ đồ.

- Nêu được chức năng của cơ quan tuần hoàn.

- Trình bày được một số việc cần làm hoặc cần tránh để giữ gìn, bảo vệ cơ quan tuần hoàn.

2. Năng lực
- Năng lực đặc thù: Nhận biết được chức năng của cơ quan tuần hoàn qua nhịp đập của tim và mạch.

- Năng lực chung: Giao tiếp, hợp tác; tự chủ và tự học; giải quyết vấn đề và sáng tạo.

3. Phẩm chất
- Thực hiện được một số việc cần làm hoặc cần tránh để giữ gìn, bảo vệ cơ quan tuần hoàn.

II. ĐỒ DÙNG DẠY HỌC
1. Đối với giáo viên
- Tài liệu: SGK, SGV

- Thiết bị dạy học: các hình ảnh trong SGK.

2. Đối với học sinh
- SGK, đồ dùng học tập.

III. Hoạt động dạy và học

Soạn dạy theo SGV Tự nhiên xã hội 3 
Tiết 3. Hoạt động 4 đến hết Hoạt động 5 (trang 132-134)

	Lớp: 3A

Tiết 2
	Thứ năm, ngày 06 tháng 3 năm 2025

Tự nhiên và xã hội

 Bài 17. Cơ quan thần kinh (tiết 1)


I. YÊU CẦU CẦN ĐẠT
1. Về nhận thức khoa học
- Chỉ và nói được tên các bộ phận chính của cơ quan thần kinh trên sơ đồ.

- Trình bày được chức năng của cơ quan thần kinh.

- Nêu được một số ví dụ về mối quan hệ với gia đình hoặc bạn bè có ảnh hưởng tốt hoặc xấu đến trạng thái cảm xúc (hoặc sức khỏe tinh thần) của mỗi người.

- Trình bày được một số việc cần làm hoặc cần transhd dể giữu gìn, bảo vệ cơ quan thần kinh.

2. Năng lực
- Năng lực đặc thù: Nhận biết được chức năng của cơ quan thần kinh qua:

· Phản ứng của cơ thể như rụt tay lại khi sờ vào vật nóng.

· Sự thay đổi cảm xúc như vui, buồn,…

- Năng lực chung: giao tiếp, hợp tác; tự chủ và tự học; giải quyết vấn đề và sáng tạo.

3. Phẩm chất:
- Thực hiện được một số việc cần làm hoặc cần tránh để giữ gìn, bảo vệ cơ quan thần kinh.

II. ĐỒ DÙNG DẠY HỌC
1. Đối với giáo viên
- Tài liệu: SGK, SGV

- Thiết bị dạy học: các hình ảnh trong SGK.

2. Đối với học sinh
- SGK, đồ dùng học tập.

III. Hoạt động dạy và học

Soạn dạy theo SGV Tự nhiên xã hội 3 

Tiết 1. Từ Mở đầu đến hết Hoạt động 2 (trang 135-137)

	Buổi sáng

Lớp: 3B
	

Thứ  sáu, ngày  07  tháng 3 năm 2025
Tự nhiên và xã hội
Bài 16. Cơ quan tuần hoàn (tiết 3)
 Bài 17. Cơ quan thần kinh (tiết 1)


**Đã soạn như tiết Tự nhiên và xã hội của lớp 3A vào chiều thứ 5, ngày 6/3/2025

	
	Ngày duyệt:   28/02/2025                            
BGH kí duyệt:

PHT. Nguyễn Thị Hằng
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